Programming lools

SOFTWARE DEVELOPMENT KIT



Microsoft. Windows™

Version 3.1

ProgrammingTools

For the Microsoft Windows Operating System

Microsoft Corporation



Information in this document is subject to change without notice and does not represent a commit-
ment on the part of Microsoft Corporation. The software, which includes information contained in any
databases, described in this document is furnished under a license agreement or nondisclosure agree-
ment and may be used or copied only in accordance with the terms of that agreement. It is against the
law to copy the software except as specifically allowed in the license or nondisclosure agreement. No
part of this manual may be reproduced in any form or by any means, electronic or mechanical, includ-
ing photocopying and recording, for any purpose without the express written permission of Microsoft
Corporation.

© 1987-1992 Microsoft Corporation. All rights reserved.
Printed in the United States of America.

ITC Zapf Chancery and ITC Zapf Dingbats fonts. Copyright © 1991 International Typeface
Corporation. All rights reserved.

Copyright © 1981 Linotype AG and/or its subsidiaries. All rights reserved. Helvetica, Palatino, Times
and Times Roman typefont data is the property of Linotype or its licensors.

Arial and Times New Roman fonts. Copyright © 1991 Monotype Corporation PLC. All rights
reserved.

Microsoft, MS, MS-DOS, QuickC, and CodeView are registered trademarks, and Windows and
QuickBasic are trademarks of Microsoft Corporation.

U.S. Patent No. 4974159

Adobe and PostScript are registered trademarks of Adobe Systems, Inc.

The Symbol fonts provided with Windows version 3.1 are based on the CG Times font, a product of
AGFA Compugraphic Division of Agfa Corporation.

Apple, Macintosh, and TrueType are registered trademarks of Apple Computer, Inc.

UNIX is a registered trademark of UNIX Systems Laboratories.

PANOSE is a trademark of ElseWare Corporation.

Epson and FX are registered trademarks of Epson America, Inc.

Hewlett-Packard, HP, and LaserJet are registered trademarks of Hewlett-Packard Company.

Lotus is a registered trademark of Lotus Development Company.

IBM and Personal System/2 are registered trademarks of International Business Machines
Corporation.

ITC Zapf Chancery and ITC Zapf Dingbats are registered trademarks of the International Typeface
Corporation.

Helvetica, Palatino, Times, and Times Roman are registered trademarks of Linotype AG and/or its
subsidiaries.

Intel is a registered trademark of Intel Corporation.

Arial and Times New Roman are registered trademarks of the Monotype Corporation PLC.

Okidata is a registered trademark of Oki America, Inc.

Document No. PC28918-0492



Contents

Chapter 1

Chapter 2

Chapter 3

INEROTUCHION. ... ix
Organization of This Manual..............cccccoeieiiiniiiieieiree et ix
Document CONVENTIONS .......ccoveiruirieieiiinieicinieiiites et saeasneas X
Creating and Editing Resources 1
1.1  Designing Images: Image Editor...........cocoverenininininnnncneneecncereceee 3
1.2 Designing Dialog Boxes: Dialog Editor ........cccooireerieniiniinenieicneneeiene 4
1.3 Designing Fonts: Font Eitor.........ccccoecerivieinieinenieiiieeceeeececneiene 5
Compiling Resources: Resource Compiler. 7
2.1  Including Resources in an AppliCation ........cccccveeceirciiecreniniecniencnneieenn 9
2.2 Creating a Resource-Definition File ...........cccoceeveiniiinennnenininnceenenenn 9
221 Single-Line Statements.........cuevevereeerieeeieeeenieneseeeeseseeseeeeseene 10
222 Multiling Statements...........coueereruerirrereeniereneneereeeee e 10
2.3 Using Resource COMPILEr .....c..coeveerieriinerinineineeeeeeeeeteeeeeereeieie v 12
2.3.1 Command-Line SYNtaX........cccceceveeiiiniiiiiinineniiieeeeees 12
232 Compiling Resources Separately...........ccccocviniiiiinninniiinne, 15
233 Defining Names for the Preprocessor ..., 16
234 Renaming the Compiled Resource File...........ccccccoviiiniiiiiiiicnecnen. 16
2.35 Controlling Which Directories the Resource Compiler Searches.... 17
2.3.6 Displaying Progress Messages ........coceoveerrererrireneeierenrenennesisesueens 18
24 Related TOPICS ...c.cvuereuerreretrreiriesieeietree ettt 18
Creating Help Files 19
3.1  About Windows Help Files......c.cocccvmernircennienicnicicicnciniccincias 21
3.2 Creating TOpic FIles ......coeeviiriiriniiiieiiieierieneniene et 21
321 Declaring Character Set, Fonts, and Colors .........coccceeveeenereciennnas 22
322 Defining Individual TOPICS.....cccereeveervienieieniiiiinieciinrcnicieiene 23
323 Setting Font Size and Name .........ccccoceeevervinennenceneneenenenreeeene 24
324 Setting Space Before and After Paragraphs ..., 24
325 Setting the Left and Right Indents.........cc.ccoevevenininiinenrnincenne 24
3.2.6 Setting Tab StOPS....c..ccciiiciiniiiiiii s 25
3.2.7 Breaking Lines........coccevuevererinienieieieietcne et 25
3.2.8 Creating Links and Pop-up TOPICS ......ccccvrereeuercrciricnciiiciinn, 26



iv

Microsoft Windows Programming Tools

Chapter 4

3.29 Creating a Keyword List.........ccceeevenieririenenininenieeieenesrenesie e 27
3.2.10  Creating Browse SEQUENCES ......c.cceeeeerirererieneeeneneneeeesseseeesienes 27
3.3 Using Graphics Files ........cccvivirinieieiieiiieeeeeeierestes e e e ne e 28
3.3.1 Inserting a Bitmap in TeXt ......ccoceveeerrierenenieeenieeeee e 29
3.3.2 Wrapping Text Around a Bitmap ........ccocceveeveeeeecieenienreeceeneeeeene 29
3.33 Using a Bitmap as @ HOt SPOt.......ccceveeieeiniecierienieieieieeeereeenen 30
334 Using a Bitmap on Different Displays .........c.cecoeeerneerecnccneccruencns 30
3.4  Creating Help Project Files ......c..ccccoveririniniieneninieeeeceeeeeeeeeeeeeeee 32
34.1 Project File SECHONS ....cccovvverierieriiniieieienenieeiee ettt 32
34.2 Using Macros in Project Files..........cccecviririinienienenieieiencnieienees 33
343 Sample Project File........cccoivirieiiinininiceceseneeeseneceeeeeseeeas 33
3.5 Using Help in a Windows APPLICAtioN .......ccccevererveererenereneneneenieneennes 34
35.1 Choosing Help from the Help Menu ........c.ccccoveivenecncnccncccnnenns 34
352 Choosing Help with the Keyboard ..........cccooeeceeeeecnninncnnennnens 36
353 Choosing Help with the MOUSE ........c.cceccverernecrennrecnecnieenns 39
354 Searching for Help with Keywords .........coccocevverevienenenencnieeeenee. 42
355 Displaying Help in a Secondary Window ...........ccocevererceerennncenne. 43
3.5.6 Canceling Help......cooeeeieeieniiieieeeeeteteeee e 44
3.6  Project File Sections and Options Reference ..........cccceeverereerencnrcrnevencenee 45
Debugging: CodeView for Windows 67
4.1  Requirements for Using CodeView for Windows.........ccccccceuevevceecerennnne. 69
4.1.1 Using CVW with a Single MONitor ......cc.eoeveirerrenenennenreeneneeneene 70
4.1.2 Using CVW with a Secondary MONitor .........cocceveeeeerneeneeneneeneennes 70
4.2 Comparing CodeView for Windows with Other
MicroSOft DEDUZZETS .....ccveveuieuieiirieieieerienteeeenete e 71
421 Differences Between CVW and SYMDEB..........cccocvevninvninnnnen. 71
422 Differences Between CVW and CodeView for MS-DOS ............... 72
4.3  Preparing Windows Applications for Debugging.........cccccoevvevreeerucnuennen. 73
4.4  Setting Up the Debugging Version of Windows ...........ccceceveecererenieneenene 73
4.5  Starting a Debugging SESSI0N. .......ccerirtrrierteririerienierieeesesseeseeeesresseenens 74
451 DiSplay OPLiONS ......ceeverierieeeienieeieisieeiesteteres et eesteaessesteeeeseesaessens 75
4.5.2 Starting a Debugging Session for a Single Application................... 75
4.5.3 Starting a Debugging Session for Multiple Instances
Of an APPLCALION......coueririeirieirieietreceec et 76
454 Starting a Debugging Session for Multiple Applications................. 76
4.5.5 Starting a Debugging Session for Dynamic-Link Libraries............. 77
4.5.6 Command-Ling OPLions .........cceceeeeerereererenieseerenserenreseeneeneeresennens 78

4.6 Saving Session InfOrmation.........c.cecceververiereeerenenirreneneeeneeeneseeseeeeneeneen 80



Contents v

Chapter 5

4.7  Working with the CodeView for Windows Screen .........c.cccocccevveueeeucennes 80
4.7.1 Using CVW Display Windows .........cccccoceiveiiiincnincinicniniiiicccnnne, 80
4.7.2 Using the Menu Bar.........cooooiiiiiiiiiiciiniecciececececceceeeen 83

4.8 AcCeSSING HelIP...oooieiieeeeeeec et 85

4.9  Displaying Application Data..........cccceviruieieieiieieiieieieteseseeeeeee e 85
49.1 Displaying Variables .........ccocerireririeineeeeteeeeeee et 86
492 Displaying EXPIressions .....c..cocoecerereeeereeeneeenenseesesseneeescsensens 87
493 Displaying Arrays and StruCtUIEs..........cocceveeervereereereenenerieeneeneenes 87
494 Using the Quick Watch Command...........cc.cocceveriiiiencnenrcnnenencne. 91
495 Tracing Windows MeSSages.........cevuevuereerueruenereereeneneneeneeseensenneenne 91
4.9.6 Displaying MEMOTY ........ccoeeeriririeeriesienieneneeneneeseseeeeseessesseeseeeaes 92
4.9.7 Displaying the Contents of REISters ........ccceceevereenierenencncerienene 97
4938 Displaying Windows MoOdUIES ........c.ccceeeirerreenereenenenenecnennens 98

4.10 Modifying Application Data .........cceeceeieieierienieriesenese et 98

4.11 Controlling Execution of Your Application..........coceeeeeeerueneeenervenuenencs 99
4.11.1  Continuous EXECULION.......ccciiriiririeieriiiirieneieeee e 99
4.11.2  Single-Step EXECUION ....covveruiriiieienieeenceeeeeee e 103
4.11.3  Animated EXECULION .....ccueeruirierieeereieiererecniccecieeeeenesee e 104
4.11.4  Jumping to a Particular Location.........c..cocceveververieniesiencncneenenne. 104
4.11.5  Interrupting Your Application.........ccccveiniiiiciiiiicncninciinene, 104

4.12 Handling Abnormal Termination of the Application..........cccccccceeeceueene 106
4.12.1 Handling a Fatal EXit.......cccccociviininiinininiiniiinciinieiicicneee 106
4.12.2  Handling a General Protection Fault .............ccoccccoiiininninnnn. 107

4.13  Ending @ SESSION ..c.eeeeuieiieiierieeieeenieeieeieesieesesseesee st esieesaeesseesaeesseesseensnes 108

4.14  Advanced TEChNIQUES .........cceririeienireeieieieeee ettt 108
4.14.1  Using Multiple Source Windows ........ccccoeevercerireeniereeneneeneenuennes 108
4.14.2  Checking for Undefined POINters.........cccoeveveriniencesienenceeenene, 108
4.14.3  Handling Register Variables.........ccccoceevrerererenenercncnencecnnennenn 109
4.14.4  Redirecting CodeView for Windows Input and Output................. 109

4.15 Modifying the TOOLS.INIFile ......c.cocoeiirirenininircnenieieesieeseneeeeane 110

4.16  Related TOPICS ....coveeeuieriieienieiirienieeeteiesie st st stese st e sae et et sseseeeeseenene 110

Advanced Debugging: 80386 Debugger 111

5.1  Preparing Symbol Files for 80386 Debugger ..........ccccevererveereereencenenne. 113

5.2 Starting 80386 DEbUZEET ......ccerieerereirieieienientesieieee et neeas 114

5.3  Entering 80386 DEDUZEET .....c.cocvuerueuirinieieinieiecicenieeeenecnreeeeereseeneen 116

54 Command SYNLAX ..c..ceceeieruereeierienientertensereeeseeressesseesessteseessessesseesnessessens 118
54.1 Command KEYS ......cceeieiereeririeieneniieteeeeetete et 118

542 Command Parameters............cooueeeieeeeeieeeeeeiieeeeieeeeeeneeeeessneeeeennns 118



vi Microsoft Windows Programming Tools

Chapter 6

Chapter 7

Chapter 8

543

544

Binary and Unary Operators........c..ceeeererererenersernieseneenesseennens
Regular EXPressions .........coeieeecierienienenerinesenieestenteseeeeeeeeeennens

5.5  Common Commands.......c..coeeieierierierieienieniereneneeereneeeseenteneessesaeeeennes
5.6  Reference of 80386 Debugger Commands ...........coeeeeueeveneneerennueneereenenn

5.7  Related Topics

Analyzing System Failures: Dr. Watson

6.1  Configuring Dr. Watson from the WIN.INI File..........cccccecvenerienenenee.
6.1.1 The SKIpInfo Entry .....cccccevveviieiieininieceeceeecieeee e
6.1.2 The ShowInfo Entry........coceeiiieiinieiiiieieececeeeeeeeveeenenn
6.1.3 The DisLen Entry.......cooveeiieieeiieeeieeeeeeeee e
6.1.4 The TrapZero ENtIY .....c..oveeieievierienieeeeeieeeeetesreseeee e
6.1.5 The GPContinue ENtry........cccoceevieviireeenieieieceteeeneeee e
6.1.6 The DisStack ENtry .....cccoceevevieieerineincieeneeneseeeeeeeeeieseesaeen
6.1.7 The LogFile ENtry .....ccoevieiiinierenicinieieceieeeeeeeeneesee e

6.2  Sample Dr. Watson Log File........cccocevvnininiiiininieiecrceeeneeesceee

6.3  Sample Dr. Watson Log File with Comments ...........ccccocerueererrernuecennene

Monitoring Messages: Spy

7.1  Selecting Options: The Options! Menu..........ccccceverveerienienieenseenseeeeenne
7.1.1 Selecting Message TYPES....coveeeveeerieenenirenieesereeeesrenesseneesaenees
7.12 Selecting the Output DEvicCe ........ccceeveeiruenirineereneneneneeneeeene
7.1.3 Selecting Frequency of Output .........c.ccceeveueeeeeemevemercnneeneenneeinens

7.2 Selecting a Window: The Window Menu...........ccceceverereneeneneeneenenennenn

7.3  Starting and Stopping Spy: The Spy Menu.......c.cocoeeeerveenieniesiennienenene

T4 Related TOPICS ..ccveeuerrereieieieienitnieieeetete et teste st sressessee e saeebesasesseeneens

Monitoring Dynamic Data Exchange Activity: DDESpy

8.1  The OutpUt MENU.......ceruerueieiiniirieieieeeeiereetee et s

8.2 The MOnitor MENU ....c..cccecererierieirinienienieiierenteenienteseseesaeseeesaesnessessenenes
8.2.1 Monitoring String-Handle Data...........ccoccevrcinricniecnccnccne,
8.2.2 Monitoring Sent or Posted DDE Messages.......c.coccoveueeveerecnnnnes
8.2.3 Monitoring Callbacks .........cceeeevierereririnirieeeeeneeteseee e
8.2.4 MONItOring EITOTS .....coveeuiriiririirieienienieeeeeeeeseee et ee e ee v

8.3 Tracking OPHONS ....cccevveriereriieienteeeetenieeie ettt sb e et st e saeeanennene
8.3.1 Tracking String Handles ...........coceeverieniineninenenceieeseeeeeneene
8.3.2 Tracking Active CONVErsations ..........c.ccceeueeeeiieinincncsesceennenns
833 Tracking Active LInKS .......ccccoueueriruevirncrnncireencceeeeecseeeeenes
834 Tracking Registered SErvers..........ccoovuvvcvevivcniniiniiciinccccciinns



Contents vii

Chapter9 Viewing the Heap: Heap Walker 195
9.1  The Heap Walker WindOW.........cccertererinernienenenencceceeene e 197

9.2 Performing File Operations: The File Menu.........ccccceeereevenncineeninnnenne 198

9.3 Waiking the Heap: The Walk Menu ..., 199

9.4  Sorting Memory Objects: The Sort Menu.........ccceceeveevceceenenenenceneennenn 199

9.5  Displaying Memory Objects: The Object Menu.........c.cccceevevveneeereennene. 200

95.1 The Show Command .........ccociriiriiriiiie e 200

9.5.2 The LocalWalk Commands........c.cccueceeerrereeineninieeneeierenieeeenns 201

9.6  Allocating Memory: The Alloc Menu.........cccoeeverenreinieninccnenccnenne 203

9.7  Determining Memory Size: The Add! Menu..........ccccocererennnicncnencnne. 203

9.8  Suggestions for Using Heap Walker.........ccccoeverievievnenninennnninneenne. 204

9.9 Related TOPICS .everveeuireieiieiiriieieetteesteete ettt ettt sre e eneens 204

Chapter 10 Analyzing Performance: Profiler 205
10.1  Overview Of Profiler.........cooieirieiiiieieeeceee et 207

10.2  Preparing to Run Profiler ...........ocoeoieiieniiiiieiicccececceee 208

10.3  Using Profiler FUNCHONS ......c.ccoeiriiieinieiniccnecceececceecreeeeeenes 208

10.4  Sampling Code ......c..coerereriririiieieieneeteere et 209

10.5 Displaying Samples........cccooirciiiiniiiiniinincecncsecce e 209

Chapter 11  Compressing and Decompressing Files 213
11.1  Compressing Files: COMPIESS.......cecueruirerrierineriietenierrenieneeneeeeeseensennees 215

11.2  Decompressing Compressed Files: Expand..........ccccoccvceveenvcnvecncnicnnnnnne 216

Appendix A Resource Compiler Diagnostic Messages 217
Appendix B Help Compiler Error Messages 229
B.1  Interpreting Error MESSAZES ......c.coverueruieierierrieienienieneeneeieeeeeenneseeseeennens 231

B.2  Error Message CateZOries ......overeererierrereenienieriietenteeensesresseeneeseeeessenne 231

B.3  FIlE EITOTS ..ottt ettt 232

B4 Project-File EITOrs .....ccooiviriririieieieseeeteeneteeteeesee e 233

B.5  MaCIO BITOIS. ..coueiiiiiierierc et 237

B.6  ConteXt-String BITOIS ........ccccooiviiiiiiiiiiiiiiiincec s 237

B.7  TOPic-File EITOTS ...c..ccovviiiiiiiiiiciciiccci s 239

B.8  MIiSCEllaneous EITOTS ... ..uvvvviiiiiieiiiieieeeeeeeeieeee e e e e e e e e eenans 240



viii

Microsoft Windows Programming Tools

Appendix C Windows Debugging Version 243
C.1  Debugging Programs..........cccceeeierieircienienteietenrenreseeeesresreesessesseseenens 245

C.11 Logging Debugging MeSSages ........ceceveerrereriiiinicieniienienieiannns 246

C.1.2 Interpreting Debugging Messages ........coevveverievieniinienieivencneenean 247

C.2  Debugging Functions and the WINDEBUGINFO Structure .................. 249

C21 WIN.INI Debugging Options .........ccccceeiiinininnineninencsieiieenees 250

C.3  Debug@ing MESSAZES. ....c.cervierueeriieiieitenieenieeienetestestesseesseesseesasesssesssesaees 251

C.4  Common Programming EITOIS........ccccooeiiviiniiniininiiiiiiiiiicciiens 254



Introduction

The Microsoft® Windows™ operating system is a single-user system for personal
computers. Microsoft provides a variety of tools you’ll find useful as you develop
Windows applications. This manual, Microsoft Windows Programming Tools, ex-
plains how to use these tools.

Organization of This Manual

Following are brief descriptions of the chapters and appendixes in this manual:

Chapter 1, “Creating and Editing Resources,” introduces three tools you can
use to create and edit resources for Windows applications. These tools are
Microsoft Image Editor IMAGEDIT.EXE), Microsoft Dialog Editor
(DLGEDIT.EXE), and Microsoft Windows Font Editor (FONTEDIT.EXE).

Chapter 2, “Compiling Resources: Resource Compiler,” describes how to use
Microsoft Windows Resource Compiler (RC) to compile application resources
and add them to an executable Windows application.

Chapter 3, “Creating Help Files,” describes how to use Microsoft Help Com-
piler, Microsoft Multiple Resolution Bitmap Compiler, and Microsoft Hotspot
Editor to develop help files.

Chapter 4, “Debugging: CodeView for Windows,” explains how to use
Microsoft CodeView® for Windows (CVW) to test the execution of your
Windows applications and examine your data simultaneously.

Chapter 5, “Advanced Debugging: 80386 Debugger,” shows how to use
Microsoft Windows 80386 Debugger (WDEB386.EXE) to test and debug
Windows applications and dynamic-link libraries (DLLSs).

Chapter 6, “Analyzing System Failures: Dr. Watson,” discusses how to use
Microsoft Windows Dr. Watson (DRWATSON.EXE) to detect and analyze
failures caused by Windows applications.

Chapter 7, “Monitoring Messages: Spy,” shows how to use Microsoft Windows
Spy (SPY.EXE) to monitor messages sent to one or more windows in your
Windows application.

Chapter 8, “Monitoring Dynamic Data Exchange Activity: DDESpy,” explains
how to use Microsoft Windows DDESpy (DDESPY.EXE) to monitor dynamic
data exchange (DDE) activity in the Windows operating system.
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Chapter 9, “Viewing the Heap: Heap Walker,” shows how to use Microsoft
Windows Heap Walker (HEAPWALK.EXE) to examine local and global heaps
used by applications and DLLs in the Windows operating system.

Chapter 10, “Analyzing Performance: Profiler,” explains how to use Microsoft
Windows Profiler to analyze and optimize the performance of applications run-
ning with the Windows operating system in 386 enhanced mode.

Chapter 11, “Compressing and Decompressing Files,” discusses how to use
Microsoft File Compression Utility (COMPRESS.EXE) and Microsoft File
Expansion Utility (EXPAND.EXE) to compress and decompress files.

Appendix A, “Resource Compiler Diagnostic Messages,” describes diagnostic
messages produced by Microsoft Resource Compiler (RC).

Appendix B, “Help Compiler Error Messages,” lists error messages that Help
Compiler can display if errors occur while you are building a help file.

Appendix C, “Windows Debugging Version,” presents information about Win-
dows diagnostic messages to help you debug applications you develop for the
Windows operating system.

Document Conventions

The following conventions are used throughout this manual to define syntax:

Convention Meaning

Bold text Denotes a term or character to be typed literally, such as a

resource-definition statement or function name (MENU or
CreateWindow), a command, or a command-line option
(/mod). You must type these terms exactly as shown.

Italic text Denotes a placeholder or variable: You must provide the

(1
|

actual value. For example, the statement SetCursorPos(X,Y)
requires you to substitute values for the X and Y parameters.

Enclose optional parameters.
Separates an either/or choice.
Specifies that the preceding item may be repeated.

BEGIN Represents an omitted portion of a sample application.

END
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In addition, certain text conventions are used to help you understand this material:

Convention Meaning

SMALL CAPITALS Indicate the names of keys, key sequences, and key combina-
tions—for example, ALT+SPACEBAR.

FULL CAPITALS Indicate filenames and paths, type names and most structure
names (which are also bold), and constants.

monospace Sets off code examples and shows syntax spacing.
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This chapter introduces three tools you can use to create and edit resources for
your Microsoft Windows applications. These tools are Microsoft Image Editor,
Microsoft Dialog Editor, and Microsoft Windows Font Editor. You can find full
documentation for these tools in Help.

1.1 Designing Images: Image Editor

With Image Editor IMAGEDIT.EXE), you can create graphical images to repre-
sent files, windows, cursors, and other objects in your Windows applications.
Image Editor provides you with a set of drawing tools for creating commonly used
shapes.

Image Editor contains context-sensitive Help that includes information about how
to create the following kinds of images:

»  Cursors, which represent the position the mouse is pointing to. They are also
called pointers.

= Bitmaps, which represent static graphical images.
® [cons, which represent files or windows.

The following illustration shows the Image Editor window after a user has opened
an icon file.

ptions Help

You must use a mouse or similar pointing device with Image Editor.



4 Microsoft Windows Programming Tools

1.2 Designing Dialog Boxes: Dialog Editor

With Dialog Editor (DLGEDIT.EXE), you can design and test a dialog box on
your screen instead of defining DIALOG statements in a resource-definition file.
Using Dialog Editor, you can add, modify, and delete controls in a dialog box.
Dialog Editor saves the changes you make as resource-definition statements. You
then compile these statements into a binary resource file that is linked to your ap-
plication’s executable file.

Dialog Editor contains context-sensitive Help that includes information about the
following topics:

How Dialog Editor works with files

Viewing the Dialog Editor window

Opening resource files, header files, and dialog boxes
Working with dialog boxes

Editing individual controls

Working with groups of controls

Moving a dialog box between resources

Working with header files

Installing custom controls
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The following illustration shows the Dialog Editor window after a user has chosen
the New command from the File menu.

. i lalog Edltnr[Untntied]‘,[Unmled]
e Edit Arrange Options Help

Dialog Title

Ld
Dialog Title

You must use a mouse or similar pointing device with Dialog Editor.

1.3 Designing Fonts: Font Editor

With Font Editor (FONTEDIT.EXE), you can modify existing fonts to create new
fonts for your applications. The Font Editor Help describes how to use Font Editor
to do the following:

= Edit letters, numbers, and other characters in a font
= Modify the height, width, and character mapping of a font
®  Change information in the font-file header

To view Help for Font Editor, start Microsoft Windows Help (WINHELP.EXE)
and open FONTEDIT.HLP.

You can use Font Editor to create and edit raster fonts. Font Editor cannot create
or modify vector or TrueType fonts.

You must use a preexisting font file to create a new font file with Font Editor.
Two font files are supplied with Font Editor: ARTM1111.FNT and
VGASYS.FNT. For a fixed-pitch (monospace) font, you can edit
ATRM1111.ENT; for a variable-pitch font, you can edit VGASYS.FNT.
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The following illustration shows the Font Editor window after a user has opened
VGASYS.ENT from the Open File dialog box.

I Fomidier-veasvsent | 0
File Edit Font Fill Width Row Column

LT
T

Char=65
Width=8
Height=16

> 2@UBCDEFGHIJKLMNOPQRSTUYWXYZ|

After creating a new font with Font Editor, you must add the new font to a font re-
source file. For information about adding a customized font to a font resource file
and using it in a Windows application, see the Microsoft Windows Guide to Pro-
gramming.

You must use a mouse or similar pointing device with Font Editor.
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Microsoft Windows Resource Compiler (RC) is a tool for the Microsoft Windows
operating system. This chapter describes how to create a resource-definition file
and how to compile your application’s resources and add them to the application’s
executable file.

2.1 Including Resources in an Application

To include resources in your Windows application, do the following:

1. Create individual resource files for cursors, icons, bitmaps, dialog boxes,
and fonts. To do this, you can use Microsoft Image Editor and Dialog Editor
(IMAGEDIT.EXE and DLGEDIT.EXE) and Microsoft Windows Font Editor
(FONTEDIT.EXE).

2. Create a resource-definition file that describes all the resources used by the ap-
plication.

3. Use RC to compile the resource-definition file.
4. Add the compiled resource files to the application’s compiled executable file.

2.2 Creating a Resource-Definition File

After creating individual resource files for your application’s icon, cursor, font bit-
map, and dialog box resources, you create a resource-definition file. A resource-
definition file is an ASCII text file with the file extension .RC.

The .RC file lists every resource in your application and describes some types of
resources in great detail. For a resource that exists in a separate file, such as an
icon or cursor, the .RC file simply names the resource and the file that contains it.
For some resources, such as a menu, the entire definition of the resource exists
within the .RC file.

An .RC file can contain either or both of the following types of information:

= Statements, which name and describe resources.

= Directives, which instruct RC to perform actions on the resource-definition file
before compiling it. Directives can also assign values to names.

The following sections describe the statements and directives you can use in a
resource-definition file. For detailed descriptions and syntax, see the Microsoft
Windows Programmer’s Reference, Volume 4.
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2.2.1 Single-Line Statements

A single-line resource-definition statement can begin with any of the following

keywords:

Keyword

Description

BITMAP

CURSOR

FONT
ICON

2.2.2 Multiline Statements

Defines a bitmap by naming it and specifying the name of the file that
contains it. (To use a particular bitmap, the application requests it by
name.)

Defines a cursor by naming it and specifying the name of the file that
contains it. (To use a particular cursor, the application requests it by
name.)

Specifies the name of a file that contains a font.

Defines an icon by naming it and specifying the name of the file that
contains it. (To use a particular icon, the application requests it by
name.)

A multiline resource-definition statement can begin with any of the following key-

words:

Keyword

Description

ACCELERATORS Defines menu accelerator keys.

DIALOG Defines a template that an application can use to create dialog
boxes.

MENU Defines the appearance and function of an application menu.

RCDATA Defines data resources. Data resources let you include binary
data directly into the executable file.

STRINGTABLE Defines string resources. String resources are null-terminated

ASCII strings that can be loaded from the executable file.

2.2.2.1 Directives

The following directives can be used as needed in the resource-definition file to in-
struct RC to perform actions or to assign values to names:

Keyword

Description

#define
#elif
#else
#endif

Defines a specified name by assigning it a given value.

Marks an optional clause of a conditional compilation block.
Marks the last optional clause of a conditional compilation block.
Marks the end of a conditional compilation block.
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Keyword Description

#if Carries out conditional compilation if a specified expression is true.

#ifdef Carries out conditional compilation if a specified name is defined.

#ifndef Carries out conditional compilation if a specified name is not defined.

#include Copies the contents of a file into the resource-definition file before RC
processes the latter.

#undef Removes the current definition of the specified name.

2.2.2.2 Sample Resource-Definition File

The following example shows an .RC file that defines the resources for an applica-
tion named Shapes:

#include "SHAPES.H"

ShapesCursor CURSOR SHAPES.CUR
ShapesIcon ICON SHAPES.ICO

ShapesMenu MENU

BEGIN
POPUP "&Shape"
BEGIN
MENUITEM "&Clear", ID_CLEAR
MENUITEM "&Rectangle™, ID_RECT
MENUITEM "&Triangle"™, ID_TRIANGLE
MENUITEM "&Star"™, ID_STAR
MENUITEM "&E11ipse"™, ID_ELLIPSE
END
END

The CURSOR statement names the application’s cursor resource ShapesCursor
and specifies the cursor file SHAPES.CUR, which contains the image for that
cursor.

The ICON statement names the application’s icon resource ShapesIcon and speci-
fies the icon file SHAPES.ICO, which contains the image for that icon.

The MENU statement defines an application menu named ShapesMenu, a pop-up
menu with five menu items.

The menu definition, enclosed by the BEGIN and END keywords, specifies each
menu item and the menu identifier that is returned when the user selects that item.
For example, the first item on the menu, Clear, returns the menu identifier
ID_CLEAR when the user selects it. The menu identifiers are defined in the appli-
cation header file, SHAPES.H.
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For more information about resource-definition files, the syntax of resource state-
ments, and how to define your own resources, see the Microsoft Windows Pro-
grammer’s Reference, Volume 4.

2.3 Using Resource Compiler

Resource Compiler (RC) serves the following functions:

= [t compiles the resource-definition file and the resource files (such as icon and
cursor files) into a binary resource (.RES) file.

= ]t combines the .RES file with the executable (.EXE) file created by the linker;
the result is an executable Windows application.

= ]t marks the Windows application as a Windows version 3.0 or Windows 3.1
application.

Note Each Windows application and dynamic-link library (DLL) must be iden-
tified with a Windows version number. For this reason, use RC on each Windows
application or DLL you build, even if it uses no resources. For more information
about Windows versions, see the descriptions of the /30 and /31 options in Section
2.3.1.1, “Specifying Options.”

2.3.1 Command-Line Syntax

To start RC, use the rec command. What you need to specify on the command line
depends on whether you are compiling resources, adding compiled resources to an
executable file, or both.

The following line shows rc command-line syntax:
rc [options] definition-file [executable-file]

Following are several ways you can use the rc command:

= To compile resources separately, use the rc command in the following form:
rc It [options] definition-file
When you use this form, RC ignores any executable file you specify.

® To compile an .RC file and add the resulting .RES file to the executable file,
use the re command in the following form:

rc [options] definition-file [executable-file]
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= To compile an application or DLL that does not have a .RES file, use the rc
command in the following form:

rc [options] dll-or-executable-file

When you use this form, the filename must explicitly have an .EXE, .DRV, or
.DLL extension.

® To simply add a compiled resource (.RES) file to an executable file, use the re
command in the following form:

rc [options] res-file.res [executable-file]

2.3.1.1 Specifying Options

The re¢ command’s options parameter can include one or more of the following op-
tions:

/30
Marks the executable file so it will run with Windows version 3.0 or Windows
version 3.1. By default, RC marks the executable file to run only with Windows
3.1.

/31
Marks the executable file so it will run only with Windows 3.1. This is the de-
fault condition.

?
Displays a list of rec command-line options.

/d
Defines a symbol for the preprocessor that you can test with the #ifdef directive.

/e
Changes the default location of global memory for a DLL from below the

Expanded Memory Specification (EMS) bank line to above the EMS bank line.
This option has no effect with Windows 3.1.

/fe newname
Uses newname for the name of the .EXE file.

/fo newname
Uses newname for the name of the .RES file.

/h
Displays a list of rc command-line options.

fi
Searches the specified directory before searching the directories specified by
the INCLUDE environment variable.
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/k
Disables the load-optimization feature of RC. If this option is not specified, the
compiler arranges segments and resources in the executable file so that all pre-
loaded information is contiguous.

This feature allows Windows to load the application much more quickly. If you
do not specify the /k option, all data segments, nondiscardable code segments,
and the entry-point code segment will be preloaded, unless any segment and its
relocation information exceed 64K. If the PRELOAD attribute is not assigned
to these segments in the module-definition (.DEF) file when you link your ap-
plication, RC will add the PRELOAD attribute and display a warning. Re-
sources and segments will have the same segment alignment. This alignment
should be as small as possible to limit the size of the final executable file. You
can set the alignment by using the link command with the /a option.

N[im32]
Specifies to Windows that the application uses expanded memory directly, ac-
cording to the Lotus/Intel/Microsoft Expanded Memory Specification (LIM
EMS), version 3.2. This option has no effect with Windows 3.1.

/m[ultinst]
Assigns each instance of the application task to a distinct EMS bank when Win-
dows is running with the EMS 4.0 memory configuration. (By default, all in-
stances of a task share the same EMS bank.) This option has no effect with
Windows 3.1.

Ip
Creates a private DLL that is called by only one application. This allows Win-
dows to use memory more efficiently, because only one application (or multi-
ple instances of the same application) calls the DLL. For example, in the
large-frame EMS memory model, the DLL is loaded above the EMS bank line,
freeing memory below the bank line. This option has no effect with Windows
3.1

Ir
Creates an .RES file from an .RC file. Use this option when you do not want to
add the compiled .RES file to the .EXE file.

It
Creates an application that runs with Windows only in protected (standard or
386 enhanced) mode. If the user attempts to run the application in real mode,
Windows will display a message that the application cannot run in real mode.
This option has no effect with Windows 3.1.

Iv
Displays messages that report on the progress of the compiler.

Ix
Prevents RC from checking the INCLUDE environment variable when search-
ing for header files or resource files.
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Iz
Prevents RC from checking for RCINCLUDE statements. When you have not
used RCINCLUDE statements, using this option can greatly improve the speed
of RC.

Options are not case-sensitive, and a hyphen (-) can be used in place of a slash
mark (/). You can combine single-letter options if they do not require any addi-
tional parameters.

2.3.1.2 Specifying the Resource-Definition File

The re command’s definition-file parameter specifies the name of the resource-
definition file that contains the names, types, filenames, and descriptions of the re-
sources to be added to the .EXE file. It can also specify the name of a compiled
.RES file, in which case RC adds the compiled resources to the executable file.

2.3.1.3 Specifying the Executable File

The rec command’s executable-file parameter specifies the name of the executable
file that the compiled resources should be added to. If you do not specify an
executable file, RC uses the executable file with the same name as the resource-
definition file (excluding the filename extension).

2.3.1.4 Renaming the Executable File

The rc command’s /fe option makes it possible for you to specify the name of the
final executable file. The following example combines MYEXE.EXE with
MYRES.RES to produce the final executable file FINAL.EXE:

rc /fe final.exe myres.res myexe.exe

2.3.2 Compiling Resources Separately

By default, RC adds the compiled resources to the specified executable file. Some-
times you might want to first compile the resources and then add them to the ex-
ecutable file in separate steps. This can be useful because resource files typically
change little after initial development. You can save time by compiling your appli-
cation’s resources separately and then adding the compiled .RES file to your ex-
ecutable file each time you recompile the .EXE file.

You can use the /r option to compile the resources separately without adding them
to the executable file. When you use this option, RC compiles the .RC file and
creates a compiled resource (.RES) file.
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For example, the following command reads the resource-definition file
SAMPLE.RC and creates the compiled resource file SAMPLE.RES:

rc -r sample.rc

In this case, RC does not add SAMPLE.RES to the executable file.

2.3.3 Defining Names for the Preprocessor

You can specify conditional branching in a resource-definition file, based on
whether a term is defined on the re command line with the /d option.

For example, suppose your application has a pop-up menu, the Debug menu, that
should appear only during debugging. When you compile the application for nor-
mal use, the Debug menu is not included. The following example shows the state-
ments that can be added to the resource-definition file to define the Debug menu:

MainMenu MENU
BEGIN

f#ifdef DEBUG
POPUP "&Debug"
BEGIN
MENUITEM "&Memory usage", ID_MEMORY
MENUITEM "&Walk data heap", ID_WALK_ HEAP
END
fendif
END

When compiling resources for a debugging version of the application, you could
include the Debug menu by using the following re¢ command:

rc -r -d debug myapp.rc

To compile resources for a normal version of the application—one that does not in-
clude the Debug menu—you could use the following r¢ command:

rc -r myapp.rc

2.3.4 Renaming the Compiled Resource File

By default, when compiling resources, RC names the compiled resource (.RES)
file with the same name as the .RC file (but not the same extension) and places it
in the same directory as the .RC file. The following example compiles
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MYAPP.RC and creates a compiled resource file named MYAPP.RES in the
same directory as MYAPP.RC:

rc -r myapp.rc

The /fo option lets you give the resulting .RES file a name that differs from the
name of the corresponding .RC file. For example, to name the resulting .RES file
NEWFILE.RES, you would type the following command:

rc -r -fo newfile.res myapp.rc

The /fo option can also place the .RES file in a different directory. For example,
the following command places the compiled resource file MY APP.RES in the
directory C:\SOURCE\RESOURCE:

rc -r -fo c:\source\resource\myapp.res myapp.rc

2.3.5 Controlling Which Directories the Resource Compiler Searches

By default, RC searches for header files and resource files (such as icon and cursor
files) first in the current directory and then in the directories specified by the
INCLUDE environment variable. (The PATH environment variable has no effect
on which directories RC searches.)

2.3.5.1 Adding a Directory to Search

You can use the /i option to add a directory to the list of directories RC searches.
The compiler then searches the directories in the following order:

1. The current directory

2. The directory or directories you specify by using the /i option, in the order in
which they appear on the rc command line

3. The list of directories specified by the INCLUDE environment variable, in the
order in which the variable lists them, unless you specify the /x option

The following example compiles the resource-definition file MYAPP.RC and adds
the compiled resources to MYAPP.EXE:

rc /i c:\source\stuff /i d:\resources myapp.rc

When compiling the resource-definition file MYAPP.RC, RC searches for header
files and resource files first in the current directory, then in CASOURCE\STUFF
and D:\RESOURCES, and then in the directories specified by the INCLUDE en-
vironment variable.
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2.3.5.2 Suppressing the INCLUDE Environment Variable

You can prevent RC from using the INCLUDE environment variable when deter-
mining the directories to search. To do so, use the /x option. The compiler then
searches for files only in the current directory and in any directories you specify
by using the /i option.

The following example compiles the resource-definition file MY APP.RC and adds
the compiled resources to MY APP.EXE:

rc /x /i c:\source\stuff myapp.rc

When compiling the resource-definition file MYAPP.RC, RC searches for

header files and resource files first in the current directory and then in
CA\SOURCE\STUFF. It does not search the directories specified by the INCLUDE
environment variable.

2.3.6 Displaying Progress Messages

By default, RC does not display messages that report on its progress as it com-
piles. You can, however, specify that RC is to display these messages. To do so,
use the /v option.

The following example causes RC to report on its progress as it compiles the
resource-definition file SAMPLE.RC, creates the compiled resource file
SAMPLE.RES, and adds the .RES file to the executable file SAMPLE.EXE:

rc /v sample.rc

2.4 Related Topics

For information about creating icons, cursors, bitmaps, dialog boxes, and fonts,
see Chapter 1, “Creating and Editing Resources.”

For an introduction to menus, controls, and dialog boxes, see the Microsoft Win-
dows Guide to Programming.

For the syntax and description of each resource statement and directive, see the
Microsoft Windows Programmer’s Reference, Volume 4.
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Microsoft Windows Help provides online help for users working with a Windows
application. Windows Help provides a practical way to present information about
your application in a format users can access easily.

This chapter introduces the tools you can use to develop Windows Help files and
to incorporate Help in Windows applications.

3.1 About Windows Help Files

Windows Help files can display information by using the following elements:

= Text in multiple fonts, sizes, and colors

= Bitmaps and metafiles with up to 16 colors

= Segmented-graphics bitmaps with embedded hot spots

= Cross-reference jumps for links to additional information
= Pop-up windows to present text and graphics

= Secondary windows to present information without the full menus and buttons
of Windows Help

m Keywords to help users find the information they need

You create help files by creating topic and graphics files and a Help project file. A
topic file contains the text for the help topic and contains the Help statements and
macros that define the format of the text and the position of graphics in each topic.
The graphics files contain the bitmaps and metafiles you want to display in the top-
ics. The project file contains a description of how to build the help file.

You use the Microsoft Help Compiler to build the final help file. Combining the
topic, graphics, and project files, the compiler creates a single help file (with the
filename extension .HLP) that you can open and view by using Windows Help.

3.2 Creating Topic Files

A topic file contains the text for the help file, as well as the statements and macros
that define the format of the text and the position of the graphics. Every topic file
consists of one or more topics. A topic is any distinct unit of information, such as
a contents screen, a conceptual description, a set of instructions, a keyboard table,
a glossary definition, a list of jumps, a picture, and so on.

Windows Help displays only one topic at a time, but a user can view any topic in a
help file by using a link to the topic or searching for keywords associated with the
topic.
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You create topic files directly by using a text editor and inserting Help statements.
You can create them indirectly by using a word processor that generates rich-text
format (RTF) files. The Help statements are an extended subset of the RTF state-
ments, which provide a wide variety of formatting capabilities. For a complete list
of Help statements, see the Microsoft Windows Programmer’s Reference,

Volume 4.

3.2.1 Declaring Character Set, Fonts, and Colors

When you create a topic file, you must ensure that the entire contents of the file
are enclosed in braces ({ }). The first statement in the file must be the \rtf state-
ment; it immediately follows the first opening brace. You should follow the \rtf
statement with a \ansi statement (or a similar statement) that specifies the charac-
ter set used in the file. The following example shows the general form for a topic
file:

{\rtfl\ansi

}

You must declare the names of the fonts you use in the file by using a \fonttbl
statement. The \fonttbl statement, enclosed in braces, contains a list of font and
family names and specifies a unique number for each font. You use these numbers
with \f statements later in the file to set specific fonts. The following \fonttbl state-
ment assigns font numbers 0, 1, and 2 to the TrueType fonts Times New Roman®,
Courier New®, and Arial®, respectively:

{\fonttbl

\f@\froman Times New Roman;
\fl\fdecor Courier New;
\f2\fswiss Arial;}

You should also use the \deff statement to set the default font for the file. Win-
dows Help uses this default font if no other font is specified. The following ex-
ample sets the default font number to zero, corresponding to the Times New
Roman font specified in the previous \fonttbl statement:

\deff@

If you use specific text colors or choose not to rely on the default text colors set by
Windows, you must define your colors by using a \colortbl statement. The
\colortbl statement, enclosed in braces, defines each color by specifying the
amount of each primary color (red, green, and blue) used in it. The statement im-
plicitly numbers the colors consecutively starting from zero. You use these color
numbers with \cf statements later in the file to set the color. The following ex-
ample creates four colors (black, red, green, and blue):
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{\colorthbl
\red@\green@\blued;
\red255\green@\blued;
\red@\greenl28\blue®;
\red@\green@\blue255;}

Although it is not shown here, you can put a semicolon immediately after the
\colortbl statement to define the default color as color 0.

3.2.2 Defining Individual Topics

A topic starts with one or more \footnote statements and ends with a \page state-
ment. All text and graphics specified between these statements belong to the topic.

Every topic must have a context string. Windows Help uses the context string to
locate the topic when the user requests to view it. You assign a context string to a
topic by using the \footnote statement and the number sign (#) footnote character.
Context strings can consist of letters, digits, and the underscore character (_). To
prevent conflicts, each context string in a help file must be unique.

You can also assign a title to the topic by using the \footnote statement and the
dollar sign ($) footnote character. Windows Help uses the title to identify the topic
in the History and Search dialog boxes. You must provide a title if you assign key-
words to the topic.

The following example defines a small topic having the context string “topicl”
and the title My Topic:

#{\footnote topicl}
${\footnote My Topic}
This is my first topic.
\par

\page

In general, you use the \par statement to mark the end of each paragraph. In this
example, the \par statement marks the end of the only paragraph in the topic.

You can add a macro to a topic by using the \footnote statement and the exclama-
tion point (!) as the footnote character. For example, the following \footnote state-
ment adds the CopyTopic macro to the topic:

1{\footnote CopyTopic()}
Windows Help executes the macro each time it displays the topic.

The total size of text and graphics data stored in a topic must not exceed 64K. (Bit-
maps included by using the bme, bml, and bmr statements do not contribute to
this total.)
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3.2.3 Setting Font Size and Name

You can set the font name and size by using the \f and \fs statements. The name is
set by using a font number specified in the \fonttbl statement. The size of the font
is specified in half-points. The following example sets the text to 10-point Times
New Roman (if the \fonttbl statement matches the example given earlier):

\fo\fs20

Once you set the font name and size, the settings apply to all subsequent text up to
the next \plain statement or until you change the name or size by using the \f or \fs
statement again. The \plain statement resets the name and font to the defaults. The
default font name is as set by the \deff statement; the default font size is 12 points.

3.2.4 Setting Space Before and After Paragraphs

You can set the amount of space before and after each paragraph by using the \sb
and \sa statements. These statements let you control the amount of space that ap-
pears between paragraphs. You specify the space in twips. (A twip is 1/1440 inch,
or 1/20 of a printer’s point.) The following example sets the space before a para-
graph to 360 twips:

\sa360

This paragraph has 360 twips space immediately before it.
\par

This paragraph also has 360 twips before it.

\par

Once you set the space before or after a paragraph, the spacing applies to all sub-
sequent paragraphs up to the next \pard statement or until you change the spacing
by using the \sa and \sb statements again. The \pard statement restores the default
spacing.

3.2.5 Setting the Left and Right Indents

When Windows Help displays its window, it automatically creates left and right
margins and wraps text to fit within these margins. The margins are positioned
slightly within the left and right edges of the window to prevent text in the topic
from being clipped by the window.

You can override these margins by setting the left and right indents for a para-
graph. The \li and \ri statements set an indent to a position relative to the corre-
sponding left and right margins. For example, the following paragraph is indented
1 inch (1440 twips) from the left margin:
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\\1i1440

This paragraph is indented 1 inch.
\par

\pard

This paragraph is not indented.

Once indents are set, they apply to all subsequent paragraphs up to the next \pard
statement. Note that the \pard statement must follow the \par statement that ends
the paragraph to be indented.

You can set an indent for the first line in a paragraph by using the \fi statement.
This allows you to create paragraphs with hanging indents. It is also useful for
creating two-column lists.

3.2.6 Setting Tab Stops

You can set tab stops by using the \tx statement. You can use one or more \tx state-
ments, each setting a specific position in twips relative to the left margin. Once
you have set tab stops, you can use the \tab statement to align subsequent text

with the next tab. The tab settings remain active until you use the \pard statement.
The following example creates a two-column list by using a tab stop and para-
graph indenting:

\fi-1440\111440\tx1440
left

\tab

right

\par

left

\tab

right

\par

\pard

3.2.7 Breaking Lines

Ordinarily, Windows Help wraps all lines in a paragraph, fitting as many words on
a line as will fit between the current left and right indents. You can force Windows
Help to break a line at a given place by using the \line statement. You can also
direct Windows Help to forego wrapping by using the \keep statement. You can
control wrapping by using the \keep and \pard statements.
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The following example uses the \keep statement to turn off word wrapping for
three short lines and uses the \pard statement to restore the default properties:

\keep

3 pairs black socks\line
5 pairs blue socks\line

2 pairs brown socks\line
\par

\pard

The following example uses the \keep and \pard statements to create three non-
wrapping paragraphs:

\keep

3 pairs black socks
\par

5 pairs blue socks

\par

2 pairs brown socks
\par

\pard

3.2.8 Creating Links and Pop-up Topics

Windows Help displays only one topic at a time. To enable users to view other top-
ics, you must create hot spots that link your topics to other topics. You create a hot
spot by using the \strike, \ul, or \uldb statement and a corresponding \v statement.
When you create a link, you provide the text for the hot spot and the context string
for the topic that is to be jumped to or displayed. The following example creates a
hot spot named Glossary and establishes a link from the hot spot to the topic hav-
ing the context string “glo1”:

You can find a list of terms used in this
help file in the {\uldb Glossary}{\v glol}.

When Windows Help displays the topic with this hot spot, it places a line under
the word Glossary and colors the word green. The context string is not shown, but
if the user clicks on the hot spot, Windows Help jumps to and displays the corre-
sponding topic.

The \strike and \uldb statements are used to create jumps to other topics. The \ul
statement creates a link to a pop-up topic. Windows Help displays pop-up topics
in a pop-up window and leaves the current topic in the main window.

You can also associate a Help macro with a hot spot in a topic. For example, the
following \uldb and \v statements create a hot spot for the ExecProgram macro:

{\uldb Clock}{\v !ExecProgram("clock.exe™, 1)}
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Windows Help executes the macro whenever the user chooses the hot spot. Win-
dows Help continues displaying the topic while it executes the macro, unless the
macro causes a jump to another topic.

3.2.9 Creating a Keyword List

You can also enable users to find and view topics by assigning keywords to the
topics. You assign a keyword by using the \footnote statement and the letter K as
the footnote character. Windows Help collects all keywords in a help file and dis-
plays them in its Search dialog box. Using this dialog box, a user can select a key-
word and view the help topics associated with it. The following example assigns
the keyword “Sample Topics” to the current topic:

#{\footnote topicl}
${\footnote My Topic}
K{\footnote Sample Topics}
This is my first topic.
\par

\page

If a keyword begins with the letter K, you must place an extra space before the
word. Multiple keywords for a topic are separated by semicolons.

A keyword can be assigned to any number of topics. When the user selects the key-
word in the Search dialog box, Windows Help displays all topics associated with
the keyword. The user then picks the one to view.

You can also create alternative keywords for a help file for use with the WinHelp
function.

3.2.10 Creating Browse Sequences

You can enable users to browse through a sequence of help topics by creating a
browse sequence and adding browse buttons to your help file. A browse sequence
typically consists of two or more related topics that are intended to be read sequen-
tially. You create a browse sequence by using the \footnote statement and the plus-
sign (+) footnote character to assign a sequence identifier. The following example
assigns a sequence identifier to the topic titled A Topic:

f#{\footnote topic5}

${\footnote A Topic}

+{\footnote shorttopics}

This is one topic in a browse sequence.
\par

\page
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Windows Help adds topics with sequence identifiers to the browse sequence and
determines the order of topics in the sequence by sorting the identifiers alphabeti-
cally. If two topics have the same identifier, Windows Help assumes that the topic
that was compiled first is to be displayed first.

Windows Help uses the sequence only if the browse buttons have been enabled.
You can enable the buttons by placing the following in the Help project file:

[CONFIG]
BrowseButtons()

For more information about the project file, see Section 3.4, “Creating Help Pro-
ject Files.”

You can create more than one browse sequence in a help file by using sequence
numbers with sequence identifiers. The sequence number consists of a colon (:)
followed by an integer. Windows Help combines all topics having the same se-
quence identifier (but different sequence numbers) into a single browse sequence
and determines the order of the topics by sorting them alphabetically. To ensure
that numerals are sorted correctly, they should have the same number of digits. For
example, the numerals 1 through 10 should be 01 through 10.

#{\footnote topicl@}

${\footnote Alpha Topic #3}

+{\footnote alpha:3}

This topic is part of the alpha browse sequence.
\par

\page

3.3 Using Graphics Files

You can add bitmaps and metafiles to your help files by using the bml, bme, and
bmr statements. These statements take the name of a graphics file and insert the
corresponding bitmap or metafile into the help file at the specified position.

Windows Help requires graphics files to be in one of the following formats:
= Windows bitmap (.BMP)

= Placeable Windows metafile (( WMF)

= Multiple-resolution bitmap (MRB)

= Segmented-graphics bitmap (.SHG)

Multiple-resolution bitmaps can be created by using the Microsoft Multiple-
Resolution Bitmap Compiler (MRBC). Segmented-graphics bitmaps can be

created by using Microsoft Windows Hotspot Editor. Only 16-color and mono-
chrome bitmaps may be used. Windows Help does not support 256-color bitmaps.
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Although the \pict statement can also be used to add bitmaps and metafiles to a
help file, the bitmap or metafile data must be inserted into the topic file rather than
specified as a separate file.

3.3.1 Inserting a Bitmap in Text

You can insert a bitmap into a paragraph as if it were a character by using the bme
statement. The statement aligns the bottom of the bitmap with the base line of the
current line of text and places the left edge of the bitmap at the next character posi-
tion. The following example inserts a bitmap into a line of text:

Press the \{bmc enter.bmp\} key to complete the task and return to
the main window.

Since the bitmap is treated as text, any paragraph properties assigned to the para-
graph also apply to the bitmap. Windows Help places text following the bitmap on
the same base line at the next available character position.

In general, bitmaps inserted as characters should be clipped to the smallest
possible size. Any extra white space at the top or bottom of the bitmap image af-
fects the alignment of the bitmap with the text and may affect the spacing between
lines.

You must not specify negative line spacing for paragraphs that contain bmc state-
ments. Doing so might cause the bitmap to appear on top of the paragraph.

3.3.2 Wrapping Text Around a Bitmap

You can place a bitmap at the left or right margin of the Help window and have
subsequent text wrap around the bitmap by using the bml or bmr statement. The
bml statement inserts a bitmap at the left margin; bmr inserts it at the right.

If you want text to wrap around a bitmap, you must place the bml or bmr state-
ment at the beginning of a paragraph. Windows Help aligns the start of the para-
graph with the top of the bitmap and wraps around the left or right edge of the
bitmap. The following example places the bitmap at the left margin and sub-
sequent text wraps around its right edge:

\{bml mybitmap.bmp\}
The text in this paragraph wraps around the right edge of the bitmap.
\par

If you place a bml or bmr statement at the end of a paragraph, Windows Help
places the bitmap under the paragraph instead of wrapping the text around the bit-
map. If you do not want text to wrap around a bitmap, place \par statements imme-
diately before and after the bml or bmr statement.
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3.3.3 Using a Bitmap as a Hot Spot

You can use bitmaps as hot spots. This enables you to create graphics, such as
icons or buttons, and use them as “jumps” to particular topics or as hot spots for
macros. The following example uses the bitmap in the MYBUTTON.BMP file to
create a link. When the user clicks the bitmap, Windows Help jumps to the topic
identfied by the context string “topic15”:

{\strike \{bml mybutton.bmp\}}{\v topicl5}

You can also divide a single bitmap into several hot spots and assign a different
link or macro to each hot spot. Such bitmaps, called segmented-graphics bitmaps,
are created by using Hotspot Editor. For example, if you have a bitmap of a dialog
box, you can assign links to each of the control windows in the dialog box, en-
abling the user to click a control window and view information about it. Seg-
mented-graphics bitmaps already contain the context strings needed for the links;
only a bml or bmr statement is needed to insert the bitmap. The \strike and \v
statements must not be used.

\{bml mydialog.shg\}

3.3.4 Using a Bitmap on Different Displays

A multiple-resolution bitmap is a single bitmap file that contains one or more bit-
maps that have been marked for use with specific displays, such as the CGA,
EGA, VGA, or 8514 displays. You use multiple-resolution bitmaps to avoid prob-
lems associated with displaying bitmaps designed for a single type of display.
Single-resolution bitmaps can have the following problems:

= Appear too big or too small on displays having different resolutions
®  Appear stretched or compressed on displays with different aspect ratios

= [ ack colors or use unintended colors on displays with different color capabili-
ties.

You create multiple-resolution bitmaps by using MRBC. The compiler, an
MS-DOS program, has the following command-line syntax:

mrbc [/s] filename ...

The filename parameter specifies the name of a Windows bitmap file. Typically,
you specify several filenames, one for each type of display. Wildcards can be

used. The compiler uses the filename of the first bitmap file as the name of the out-
put file but gives the output file the filename extension .MRB. The following ex-
ample combines the bitmap files MYBUTTON.EGA, MYBUTTON.VGA, and
MYBUTTON.854 into the multiple-resolution bitmap file MYBUTTON.MRB:

mrbc mybutton.ega mybutton.vga mybutton.854
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In this example, the compiler checks the biXPelsPerMeter and biYPelsPerMeter
members of the BITMAPINFOHEADER structure in each bitmap file to deter-
mine the display type for the bitmap. (For a description of the BITMAPINFO-
HEADER structure, see the Microsoft Windows Programmer’s Reference,
Volume 3.) If these members are set to zero, the compiler prompts for the display
type with a message such as the following:

Please enter the monitor type for the bitmap mybutton.ega:

You must enter at least the first character of one of the following display-type
names: CGA, EGA, VGA, or 8514. The compiler sets the display type you
specify, but it does not check that the type is valid. For example, if you specify
VGA for an EGA bitmap, the compiler marks it as a VGA bitmap. The result may
be undesirable.

The /s option, specifying silent mode, speeds up compilation if the names of the
bitmap files conform to the MRBC filename convention. If you use the /s option,
the compiler uses the first character of the filename extension to determine the dis-
play type for the bitmap, as described in the following list:

Letter Meaning

C CGA bitmap
E EGA bitmap
A% VGA bitmap
8 8514 bitmap

If the filename extension starts with any other character, MRBC assumes a VGA
bitmap. The following example creates the multiple-resolution bitmap file
MYBUTTON.MRB, containing bitmaps for EGA, VGA, and 8514 displays:

mrbc /s mybutton.ega mybutton.vga mybutton.854

The compiler never writes over existing multiple-resolution bitmap files. If the out-
put file already exists, the compiler displays an error message.

You insert multiple-resolution bitmaps into your help file by using the same state-
ments as for Windows bitmaps. For example, the following bme statement inserts
the bitmaps from the MYBUTTON.MRB file:

Click the \{bmc mybutton.mrb\} button to complete the task and
return to the main window.

Before displaying a multiple-resolution bitmap, Windows Help checks the display
type for the computer and then selects the bitmap that has the closest matching res-
olution, aspect ratio, and color capabilities. Windows Help never displays more
than one bitmap from a multiple-resolution bitmap file.
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3.4 Creating Help Project Files

This section describes the format and contents of the Help project file (.HPJ) used
to build the help file. The project file contains all the information the Microsoft
Help Compiler needs to combine topic files and other elements into a help file.

3.4.1 Project File Sections

Every project file consists of one or more sections. Each section has a section
name, enclosed in brackets ([]), that defines the purpose and format of statements
and options in the section. Following are the sections used in project files:

Section Description

[OPTIONS] Specifies options that control the build process. This section is op-
tional. If this section is used, it should be the first section listed in
the project file, so that the options will apply during the entire
build process.

[FILES] Specifies topic files to be included in the build. This section is re-
quired.

[BUILDTAGS] Specifies valid build tags. This section is optional.

[CONFIG] Specifies Help macros that define nonstandard menus, buttons, and

macros used in the help file. This section is required if the help file
uses any of these features. This section is new for Windows 3.1.

[BITMAPS] Specifies bitmap files to be included in the build. This section is
not required if the project file lists a path for bitmap files by using
the BMROOT or ROOT option.

[MAP] Associates context strings with context numbers. This section is op-
tional.

[ALIAS] Assigns one or more context strings to the same topic. This section

is optional.

[WINDOWS] Defines the characteristics of the primary Help window and the
secondary-window types used in the help file. This section is re-
quired if the help file uses secondary windows. This section is new
for Windows 3.1.

[BAGGAGE] Lists files that are to be placed within the help file (which contains
its own file system). This section is optional.

Every project file requires a [FILES] section. This section names the topic files.
Most project files also have an [OPTIONS] section that specifies how to build the
help file. A very useful option in the [OPTIONS] section is the COMPRESS op-
tion, which specifies whether the help file should be compressed or uncompressed.
Compressing a help file reduces its size considerably and saves valuable disk
space.
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The following example creates a compressed help file from two topic files,
MAIN.RTF and MENUS.RTF:

[OPTIONS]
COMPRESS=TRUE

[FILES]
MAIN.RTF
MENUS.RTF

3.4.2 Using Macros in Project Files

You can add macros to the [CONFIG] section of a project file. Since Windows
Help executes the macros when it first opens the help file, macros that create
menus, menu items, and buttons are typically placed in this section. If there is
more than one macro listed in the [CONFIG] section, Windows Help executes
them in the order in which they are listed.

You can create new menu items and buttons for Windows Help by using such mac-
ros as CreateButton and InsertMenu. These macros define other Help macros
and associate them with the menu items and buttons. Windows Help executes
these macros when the user chooses a corresponding menu item or button. Macros
that create Help buttons, menus, or menu items remain in effect until the user quits
Windows Help or opens a new help file.

You can extend the capabilities of Windows Help by developing your own
dynamic-link libraries (DLLs) and defining Help macros that call functions in the
libraries. To define Help macros that call DLL functions, you must register each
function and its corresponding library by using the RegisterRoutine macro in the
[CONFIG] section of the project file.

For a complete list of Help macros, see the Microsoft Windows Programmer’s Ref-
erence, Volume 4.

3.4.3 Sample Project File

The following example is a sample project file for the Cardfile application. Com-
ments, marked by a beginning semicolon (;), indicate the purpose of each section
in the file:
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; Options used to define the Help title bar and icon
[OPTIONS]

ROOT=C:\HELP
BMROOT=C:\HELP\ART
CONTENTS=cont_idx_card
TITLE=Cardfile Help
ICON=CARDHLP.ICO
COMPRESS=0FF

WARNING=3

REPORT=0N
ERRORLOG=CARD.BUG

; Files used to build Cardfile Help
[FILES]

RTFTXT\COMMANDS .RTF
RTFTXT\HOWTO.RTF

RTFTXT\KEYS.RTF

RTFTXT\GLOSSARY .RTF

; Button macros and Using Help file

[CONFIG]

CreateButton("btn_up", "&Up", "JumpContents(*HOME.HLP')")
BrowseButtons()

SetHelpOnFile("APPHELP.HLP")

; Secondary-window characteristics
[WINDOWS]
picture = "Samples", (123, 123, 256, 256), @, (@, 255, 255), (255, @, @)

3.5 Using Help in a Windows Application

Windows applications can offer help to their users by using the WinHelp function
to start Windows Help and display topics in the application’s help file. The Win-
Help function gives a Windows application complete access to the help file, as
well as to the menus and commands of Windows Help. Many applications use
WinHelp to implement context-sensitive Help. Context-sensitive Help enables
users to view topics about specific windows, menus, menu items, and control win-
dows by selecting the item with the keyboard or the mouse. For example, a user
can learn about the Open command on the File menu by selecting the command
(using the direction keys) and pressing the F1 key.

3.5.1 Choosing Help from the Help Menu

Every application should provide a Help menu to allow the user to open the help
file with either the keyboard or the mouse. The Help menu should contain at least
one Contents menu item that, when chosen, displays the contents or the main topic
in the help file. To support the Help menu, the application’s main window proce-
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dure should check for the Contents menu item and call the WinHelp function, as
in the following example:

case WM_COMMAND:
switch (wParam) {
case IDM_HELP_CONTENTS:
WinHelp(hwnd, "myhelp.hlp", HELP_CONTENTS, @L);
return 0OL;

}
break;

You can add other menu items to the Help menu for topics containing general in-
formation about the application. For example, if your help file contains a topic that
describes how to use the keyboard, you can place a Keyboard menu item on the
Help menu. To support additional menu items, your application must specify
either the context string or the context identifier for the corresponding topic when
it calls the WinHelp function. The following example uses a Help macro to
specify the context string IDM_HELP_KEYBOARD for the Keyboard topic:

case IDM_HELP_KEYBOARD:
WinHelp(hwnd, "myhelp.hlip", HELP_COMMAND,
(LPSTR)"JumpID(\"myhelp.h1p\",\"IDM_HELP_KEYBOARD\")");
return OL;

A better way to display a topic is to use a context identifier. To do this, the help
file must assign a unique number to the corresponding context string, in the
[MAP] section of the project file. For example, the following section assigns the
number 101 to the context string IDM_HELP_KEYBOARD:

[MAP]
IDM_HELP_KEYBOARD 101

An application can display the Keyboard topic by specifying the context identifier
in the call to the WinHelp function, as in the following example:

ftdefine IDM_HELP_KEYBOARD 101

WinHelp(hwnd, "myhelp.hlp", HELP_CONTEXT, (DWORD)IDM_HELP_KEYBOARD);

To make maintenance of an application easier, most programmers place their de-
fined constants (such as IDM_HELP_KEYBOARD in the previous example) in a
single header file. As long as the names of the defined contants in the header file
are identical to the context strings in the help file, you can include the header file
in the [MAP] section to assign context identifiers, as shown in the following ex-
ample:
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[MAP]
#include <myhelp.h>

If a help file contains two or more Contents topics, the application can assign one
as the default by using the context identifier and the HELP_SETCONTENTS
value in a call to the WinHelp function.

3.5.2 Choosing Help with the Keyboard

An application can enable the user to choose a help topic with the keyboard by in-
tercepting the F1 key. Intercepting this key lets the user select a menu, menu item,
dialog box, message box, or control window and view Help for it with a single
keystroke.

To intercept the F1 key, the application must install a message-filter procedure by
using the SetWindowsHook function. This allows the application to examine all
keystrokes for the application, regardless of which window has the input focus. If
the filter procedure detects the F1 key, it posts a WM_F1DOWN message (applica-
tion-defined) to the application’s main window procedure. The procedure then de-
termines which help topic to display.

The filter procedure should have the following form:

int FAR PASCAL FilterFunc(nCode, wParam, 1Param)
int nCode;
WORD wParam;
DWORD 1Param;
{
LPMSG T1pmsg = (LPMSG)1Param;

if ((nCode == MSGF_DIALOGBOX || nCode == MSGF_MENU) &&
Tpmsg->message == WM_KEYDOWN && Tpmsg->wParam == VK_F1) {
PostMessage(hWnd, WM_F1DOWN, nCode, 0OL);
}
DefHookProc(nCode, wParam, 1Param, &IpFilterFunc);

return 0;
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The application should install the filter procedure after creating the main window,
as shown in the following example:

TpProcInstance = MakeProcInstance(FilterFunc, hInstance);
if (1pProcInstance == NULL)
return FALSE;

1pFilterFunc = SetWindowsHook (WH_MSGFILTER, TpProcInstance);

Like all callback functions, the filter procedure must be exported by the applica-
tion.

The filter procedure sends a WM_F1DOWN message only when the F1 key is
pressed in a dialog box, message box, or menu. Many applications also display the
Contents topic if no menu, dialog box, or message box is selected when the user
presses the F1 key. In this case, the application should define the F1 key as an accel-
erator key that starts Help.

To create an accelerator key, the application’s resource-definition file must define
an accelerator table, as follows:

1 ACCELERATORS
BEGIN

VK_F1, IDM_HELP_CONTENTS, VIRTKEY
END

To support the accelerator key, the application must load the accelerator table by
using the LoadA ccelerators function and translate the accelerator keys in the
main message loop by using the TranslateAccelerator function.

In addition to installing the filter procedure, the application must keep track of
which menu, menu item, dialog box, or message box is currently selected. In other
words, when the user selects an item, the application must set a global variable in-
dicating the current context. For dialog and message boxes, the application should
set the global variable immediately before calling the DialogBox or MessageBox
function. For menus and menu items, the application should set the variable when-
ever it receives a WM_MENUSELECT message. As long as identifiers for all
menu items and controls in an application are unique, an application can use code
similar to the following example to monitor menu selections:
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case WM_MENUSELECT:
/%
* Set dwCurrentHelpld to the Help ID of the menu item that is
* currently selected.
*/

if (HIWORD(1Param) == @) /* no menu selected */
dwCurrentHelpId = ID_NONE;

else if (1Param & MF_POPUP) { /* pop-up selected */
if ((HMENU)wParam == hMenuFile)
dwCurrentHelpIld = ID_FILE;
else if ((HMENU)wParam == hMenuEdit)
dwCurrentHelpId = ID_EDIT;
else if ((HMENU)wParam == hMenuHelp)
dwCurrentHelpId = ID_HELP;
else
dwCurrentHelpId = ID_SYSTEM;
}

else /* menu item selected */
dwCurrentHelpId = wParam;

break;

In this example, the AMenuFile, hMenuEdit, and hMenuHelp parameters must pre-
viously have been set to specify the corresponding menu handles. An application
can use the GetMenu and GetSubMenu functions to retrieve these handles.

When the main window procedure finally receives a WM_FIDOWN message, it
should use the current value of the global variable to display a help topic. The ap-
plication can also provide Help for individual controls in a dialog box by determin-
ing which control has the focus at this point, as shown in the following example:

case WM_F1DOWN:
/%
* If there is a current Help context, display it.
*/

if (dwCurrentHelpId != ID_NONE) {
DWORD dwHelp = dwCurrentHelpld;

/*

* Check for context-sensitive Help for individual dialog
* box controls.

*/

if (wParam == MSGF_DIALOGBOX) {
WORD wID = GetWindowWord(GetFocus(), GWW_ID);
if (wID != IDOK && wID != IDCANCEL)
dwHelp = (DWORD) wID;
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WinHelp(hWnd, szHelpFileName, HELP_CONTEXT, dwHelp);

/%

* This call is used to remove the highlighting from the
* System menu, if necessary.

*/

DrawMenuBar (hWnd);
}

break;

When the application ends, it must remove the filter procedure by using the
UnhookWindowsHook function and free the procedure instance for the function
by using the FreeProcInstance function.

3.5.3 Choosing Help with the Mouse

An application can enable the user to choose a help topic with the mouse by inter-
cepting mouse input messages and calling the WinHelp function. To distinguish
requests to view Help from regular mouse input, the user must press the SHIFT+F1
key combination. In such cases, the application sets a global variable when the
user presses the key combination and changes the cursor shape to a question-mark
pointer to indicate that the mouse can be used to choose a help topic.

To detect the SHIFT+F1 key combination, an application checks for the VK_F1
virtual-key value in each WM_KEYDOWN message sent to its main window pro-
cedure. It also checks for the VK_ESCAPE virtual-key code. The user presses the
ESC key to quit Help and restore the mouse to its regular function. The following
example checks for these keys:
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case WM_KEYDOWN:
if (wParam == VK_F1) {

/% If Shift-F1, turn Help mode on and set Help cursor. */

if (GetKeyState(VK_SHIFT)) {

bHelp = TRUE;

SetCursor(hHelpCursor);

return (DefWindowProc(hwnd, message, wParam, 1Param));
}

/* If F1 without shift, call Help main index topic. */

else {
WinHelp(hwnd,"myhelp.h1p",HELP_CONTENTS,QL);
}
}

else if (wParam == VK_ESCAPE && bHelp) {
/* Escape during Help mode: turn Help mode off. */

bHelp = FALSE;
SetCursor((HCURSOR) GetClassWord(hWnd, GCW_HCURSOR));
}

break;

Until the user clicks the mouse or presses the ESC key, the application responds to
WM_SETCURSOR messages by resetting the cursor to the arrow and question-
mark combination.

case WM_SETCURSOR:
/%
* In Help mode, it is necessary to reset the cursor in response
* to every WM_SETCURSOR message. Otherwise, by default, Windows
# will reset the cursor to that of the window class.
*/

if (bHelp) {
SetCursor(hHelpCursor);
break;

}

return (DefWindowProc(hwnd, message, wParam, 1Param));
case WM_INITMENU:
if (bHelp) {

SetCursor(hHelpCursor);
}

return (TRUE);
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If the user clicks the mouse button in a nonclient area of the application window
while in Help mode, the application receives a WM_NCLBUTTONDOWN mes-
sage. By examining the wParam value of this message, the application can deter-
mine which context identifier to pass to WinHelp.

case WM_NCLBUTTONDOWN:
/*
* If in Help mode (Shift+Fl), display context-sensitive
* Help for nonclient area.
*/

if (bHelp) {
dwHelpContextId =
(wParam == HTCAPTION) ?(DWORD) HELPID_TITLE_BAR:

(wParam == HTSIZE) ? (DWORD) HELPID_SIZE_BOX:

(wParam == HTREDUCE) ? (DWORD) HELPID_MINIMIZE_ICON:
(wParam == HTZOOM) ? (DWORD) HELPID_MAXIMIZE_ICON:
(wParam == HTSYSMENU) ?(DWORD) HELPID_SYSTEM_MENU:
(wParam == HTBOTTOM) ? (DWORD) HELPID_SIZING_BORDER:
(wParam == HTBOTTOMLEFT) ? (DWORD) HELPID_SIZING_BORDER:
(wParam == HTBOTTOMRIGHT) ?(DWORD) HELPID_SIZING_BORDER:
(wParam == HTTOP) ?(DWORD) HELPID_SIZING_BORDER:

(wParam == HTLEFT) ?(DWORD) HELPID_SIZING_BORDER:
(wParam == HTRIGHT) ?(DWORD) HELPID_SIZING_BORDER:
(wParam == HTTOPLEFT) ?(DWORD) HELPID_SIZING_BORDER:
(wParam == HTTOPRIGHT) ? (DWORD) HELPID_SIZING_BORDER:
(DWORD) OL;

if (1((BOOL) dwHelpContextId))
return (DefWindowProc(hwnd, message, wParam, 1Param));
bHelp = FALSE;
WinHelp(hWnd, szHelpFileName, HELP_CONTEXT, dwHelpContextId);
break;
}

return (DefWindowProc(hWnd, message, wParam, 1Param));

If the user clicks a menu item while in Help mode, the application intercepts the
WM_COMMAND message and sends the Help request:

case WM_COMMAND:
/* In Help mode (Shift-F1)? =/
if (bHelp) {
bHelp = FALSE;

WinHelp(hWnd,szHelpFileName,HELP_CONTEXT, (DWORD)wParam);
return NULL;
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3.5.4 Searching for Help with Keywords

An application can enable the user to search for help topics based on full or partial
keywords. This method is similar to employing the Search dialog box in Windows
Help to find useful topics. The following example searches for the keyword “Key-
board” and displays the corresponding topic, if found:

WinHelp(hwnd, "myhelp.hlp", HELP_KEY, "Keyboard");

If the topic is not found, Windows Help displays an error message. If more than
one topic has the same keyword, Windows Help displays only the first topic.

An application can give the user more options in a search by specifying partial key-
words. When a partial keyword is given, Windows Help usually displays the
Search dialog box to allow the user to continue the search or return to the applica-
tion. However, if there is an exact match and no other topic exists with the given
keyword, Windows Help displays the topic. The following example opens the
Search dialog box and selects the first keyword in the list starting with the letters
Ke:

WinHelp(hwnd, "myhelp.hlp™, HELP_PARTIALKEY, "Ke");

When the HELP_KEY and HELP_PARTIALKEY values are specified in the
WinHelp function, Windows Help searches the K keyword table. This table con-
tains keywords generated by using the letter K with \footnote statements in the
topic file. An application can search alternative keyword tables by specifying the
HELP_MULTIKEY value in the WinHelp function. In this case, the application
must specify the footnote character and the full keyword in a MULTIKEYHELP
structure, as follows:

HANDLE hmkh;

MULTIKEYHELP far =*mkh;
char *szKeyword = "Frame";
WORD wSize;

wSize = sizeof (MULTIKEYHELP) + T1strlen(szKeyword);

hmkh = GlobalAlloc(GHND, (DWORD)wSize);
if (hmkh == NULL)
break;
mkh = (MULTIKEYHELP far *) GlobalLock(hmkh);

mkh->mkSize wSize;
mkh->mkKeylist L'
Tstrcpy(mkh->szKeyphrase, szKeyword);

WinHelp(hwnd, "myhelp.hlp", HELP_MULTIKEY, (DWORD)mkh);

GlobalUnlock(hmkh);
GlobalFree(hmkh);
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If the keyword is not found, Windows Help displays an error message. If more
than one topic has the keyword, Windows Help displays only the first topic. (For a
full description of the MULTIKEYHELP structure, see the Microsoft Program-
mer’s Reference, Volume 3.)

Applications cannot use alternative keyword tables unless the MULTIKEY op-
tion is specified in the [OPTIONS] section of the project file.

3.5.5 Displaying Help in a Secondary Window

An application can display help topics in secondary windows instead of in Win-
dows Help’s main window. Secondary windows are useful whenever the user does
not need the full capabilities of Windows Help. The Windows Help menus and but-
tons are not available in secondary windows.

To display Help in a secondary window, the application specifies the name of the
secondary window along with the name of the help file. The following example
displays the help topic having the context identifier IDM_FILE_SAVE in the sec-
ondary window named wnd_menu:

WinHelp(hwnd, "myhelp.hlp>wnd_menu", HELP_CONTEXT, IDM_FILE_SAVE);

The name and characteri